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NOTE: 
If the IPTC Core panels have been installed in your version of Adobe Photoshop CS, they should 
appear as seen in the screen below or on the following pages (this user guide alternates between 
screen grabs for Mac and Windows operating systems). See appendix section 1 for detailed 
instructions on where to download and how to install the panels.  
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1 Introduction 
 
This document is designed to introduce photographers to use of the IPTC Core metadata schema. 
For more in-depth information, including the complete schema, please visit 
http://www.iptc.org/iptc4xmp/. 
 

1.1 Brief Background of IPTC Metadata 
 
The IPTC’s older standard for metadata, the Information Interchange Model (IIM), defined a large 
set of metadata properties. In the early nineties a subset of this IIM was adopted as the well known 
"IPTC Headers" supported in JPEG, TIFF and PSD files by Adobe Photoshop. 
 
The IPTC Core is the latest revision of the International Press Telecommunications Council IIM 
schema, designed to use the Extensible Metadata Platform (XMP) developed by Adobe in 2001. 
XMP was first introduced in Adobe Photoshop 7.0 and Adobe Acrobat 5.0. With XMP, legacy 
IPTC IIM metadata, new and customized metadata and metadata from other standards (such as 
EXIF camera data) can be recorded using a common data format based on XML (Extensible 
Markup Language http://www.w3.org/XML/). This information can be stored inside JPEG, TIFF, 
and PSD files as well as other file types including PDF. Since its introduction a number of other 
software vendors have added XMP support in their products. 
 

1.2 Four panels for Four Key Sets of Properties 
 

 
 
The new IPTC Core XMP schema uses properties from the older IIM standard in addition to new 
metadata properties, and it specifies XMP to store metadata in files. The IPTC Core custom panels 
provide a view of metadata that’s labeled and organized so it is easier for photographers to use the 
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IPTC Core schema. The IPTC Core panels concentrate all key sets of properties needed by 
photographers into four sections or panels.  
 
The first focuses on the Contact Information, the second on basic information about the Content of 
the photograph, the third with more abstract Image information relating to the photograph. The final 
section, Status information, relates to image management, workflow and copyright.  
 
If you do not see these panels in your version of Adobe Photoshop, see Appendix 1, for details on 
where to download, and steps on how to install into Windows or Mac versions of Adobe Photoshop.  
 
 

1.3 Backward Compatibility Issues 
 
The same information can appear multiple times within Adobe Photoshop's Custom panels. The 
data is not duplicated. It is stored only once, and all the panels and schemas that read or write to that 
field use it as a “shared property.” Some IPTC Core properties already appear as part of Adobe’s 
Description, Origin and Categories in the File Info panels as well as the Adobe Photoshop File 
Browser’s Metadata panel. As an example, enter the name “John Doe” in the “Creator” field of the 
"IPTC Contact" panel, then switch to the Adobe Photoshop “Description” panel—notice that the 
name “John Doe” automatically appears in the "Author" field in that panel. Change that “Author” 
entry to “Jane Doe” and it will appear in the “Creator” field in the IPTC Contact panel using the 
new name. Both panels simply provide two different views of the same metadata.  
 
When image files are opened and saved by Adobe Photoshop (version 7.01 or higher), the “IPTC 
Headers” stored within those files are synchronized with the stored XMP metadata. To maintain 
compatibility with older versions of Adobe Photoshop, no pre-existing mappings have changed. 
 
Workflow interoperability is another reason why some metadata appears shared. For example, many 
types of documents need a “Title” (technical specifications, tax forms, blueprints), but only news 
items need an IPTC Subject Code. If another metadata standard has already defined a useful 
property, it is simply reused in the IPTC Core schema. In many cases (title and keywords are two 
examples) this mapping was already established by Adobe Photoshop’s mapping of binary IPTC 
metadata to XMP. Likewise, metadata entered using the IPTC Core panels will continue to appear 
in other locations. The IPTC Core custom panel fields that are shared are noted in the descriptions 
of each field that follow.  
 

Iptc4xmpCore_1.0-doc-CpanelsUserGuide_13.doc Page 6 of  22 
  © 2005 International Press Telecommunications Council  |  www.iptc.org 



IPTC Core Schema for XMP - CS panels User Guide [Production/PublicRelease]  
Legend for this users guide: 
 
Adobe Photoshop CS IPTC Core interface label  [IPTC Core XMP Schema property name] 
Description of field and how it should be used. 
Note(s): on where the data will be shared by other fields in the standard Adobe Photoshop “File 
Info” panel or other schemas. 
 

2 IPTC Contact panel 
(use this panel to record the photographer’s contact information) 

 

 
 

Creator  [Creator]  
This field should contain your name, or the name of the person who created the photograph. If it is 
not appropriate to add the name of the photographer (for example, if the identify of the 
photographer needs to be protected) the name of a company or organization can also be used. Once 
saved, this field should not be changed by anyone. This field does not support the use of commas or 
semi-colons as separator. 
Note: This field is “shared” with the “Author” field in the Description Panel of the Adobe 
Photoshop File Info field. 
 
Creator’s Job Title  [CreatorJobtitle] 
This field should contain the job title of the photographer. Examples might include titles such as: 
Staff Photographer, Freelance Photographer, or Independent Commercial Photographer. Since this 
is a qualifier for the Creator field, the Creator field must also be filled out.  
Note: This field is “shared” with the “Author Title” field in the Description Panel of the Adobe 
Photoshop File Info field (only appears in versions of Adobe products later than CS). 
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Address (Contact info) [CiAdrExtadr] 
The address field is a multi-line field. Enter your company name and all required information to 
locate the building or postbox to which mail should be sent.  
 
City (Contact info)  [CiAdrCity] 
Enter the name of the city in which your business is located.  
 
State/ Province (Contact info)  [CiAdrRegion] 
Enter the name of the State or Province in which your business is located. Since the abbreviation for 
a State or Province may be unknown to those viewing your metadata internationally, consider using 
the full spelling of the name.  
 
Postal Code (Contact info)  [CiAdrPcode] 
Enter the local postal code (such as ZIP code) in which your business is located. 
 
Country (Contact info) [CiAdrCtry] 
Enter the name of the country in which your business is located. 
 
Phone(s)  (Contact info)  [CiTelWork] 
Enter your business or work telephone number here. Multiple numbers can be given, separate them 
with a comma.  Be sure to include the complete international format of a phone number which is: 
+{countrycode} ({regional code}) {phone number} - {extension if required}  
e.g. +1 (212) 1234578  
 
Email(s) (Contact info) [CiEmailWork]  
Enter your business or work email address. Multiple email addresses can be given, separate them 
with a comma.   
 
Website( s) (Contact info)  [CiUrlWork] 
Enter the URL or web address for your business. Multiple addresses can be given, separate them 
with a comma.   
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3 IPTC Content panel 
(use this panel to describe the visual content of the image) 

 

 
 

Headline  [Headline]  
A headline is a brief publishable synopsis/summary of the contents of the photograph. The Headline 
term should not be confused with the Title term. 
Note: This field is “shared” with the “Headline” field in the Origin Panel of the Adobe Photoshop 
File Info field. 
 
Description  [Description] 
The Description field, often referred to as a “caption” is used to describe the who, what and why of 
what is happening in the photograph. If there is a person or people in the image, this caption might 
include their names, and/or their role in the action that is taking place. If the image is of a location, 
then it should give information regarding the location. Don’t forget to also include this same 
“geographical” information in the Image panel (location, city, state/province, country) of the IPTC 
Core. The amount of detail you include will depend on the image and whether the image is 
documentary or conceptual. Typically, editorial images come with complete caption text, while 
advertising images may not.  
Note: This field is “shared” with the “Description” field in the Description panel of the Adobe 
Photoshop File Info field. 
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Keywords  [Keywords] 
Enter keywords and terms or phrases used to express the subject of the content seen in the 
photograph.  Keywords may be free text (i.e. they are not required to be taken from a controlled 
vocabulary). Values from the controlled vocabulary IPTC Subject Codes must be placed into the 
“Subject Code” field.   
Note: This field is “shared” with the “Keyword” field in the Description panel of the Adobe 
Photoshop File Info field. 
 
IPTC Subject Code  [SubjectCode] 
This field can be used to specify and categorize the content of a photograph by using one or more 
subjects as listed in the IPTC “Subject NewsCode” taxonomy (available from 
http://www.newscodes.org/). Each subject is represented as an 8 digit numerical string in an 
unordered list. Only subjects from a controlled vocabulary should be used in this field, free-choice 
text should be entered into the Keyword field. 
 
Description writer  [DescriptionWriter] 
Enter the name of the person involved in writing, editing or correcting the description of the 
photograph in this field. For individual photographers this will typically be your own name, as you 
are the person that is entering the image metadata.  
Note: This field is “shared” with the “Description Writer” field in the Description panel of the 
Adobe Photoshop File Info field. 
 

4 IPTC Image panel 
(use this panel for formal descriptive information about the image) 
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Date Created  [DateCreated] 
Use this field to record the date of when the photograph was taken, not the date when you scanned 
or edited the image. If you use a digital camera, you can look at the EXIF data for the date stamp. 
Note: This field is “shared” with the “Date Created” field in the Origin panel of the Adobe 
Photoshop File Info field. You can use the Origin panel’s “Today button” to set IPTC Image 
panel’s Date Created. 
  
Intellectual Genre  [IntellectualGenre] 
Use this field to describe the “type” of use that a photograph fulfills in terms of its intellectual or 
journalistic characteristics. For example, at a newspaper, Intellectual Genre labels might include 
terms like daybook, obituary, press release, or transcript. A magazine might use terms like actuality, 
interview, background, feature, summary, or wrap-up. For best results, organizations should use a 
set of terms from a controlled vocabulary that they have developed. A sample taxonomy of 
“Intellectual genre” terms developed by the IPTC is available from http://www.newscodes.org/. The 
PRISM working group of the IDEAlliance has also developed a set of terms that can be referenced 
at http://prismstandard.org/. 
  
IPTC Scene [Scene] 
This field is used to describe the scene of a photo using one or more terms from the IPTC "Scene-
NewsCodes" controlled vocabulary (available from http://www.newscodes.org/). The IPTC Scene 
is represented as a 6 digit numerical string in an unordered list. 
 
Location  [Location]   
Enter the name of a location shown in the photograph. This location name could be the name of a 
specific area within a city (Manhattan) or the name of a well known location (Pyramids of Giza) or 
(natural) monument outside a city (Grand Canyon). Location is the most specific term, at the fourth 
level of a top-down geographical hierarchy. 
 
City  [City]  
Enter the name of the city that is pictured in the photograph. If there is no city, you can use the 
location field alone to specify where the photograph was taken. City is at the third level of a top-
down geographical hierarchy. 
Note: This field is “shared” with the “City” field in the Origin panel of the Adobe Photoshop File 
Info field. 
 
State/Province  [Province-State]  
Enter the name of the subregion of a country–usually referred to as either a State or Province – that 
is pictured in the image. Since the abbreviation for a State or Province may be unknown to those 
viewing your metadata internationally, consider using the full spelling of the name. Province/State 
is at the second level of a top-down geographical hierarchy. 
Note: This field is “shared” with the “State/Province” field in the Origin panel of the Adobe 
Photoshop File Info field. 
 
Country  [Country]  
Enter the full name of the country pictured in the photograph. This field is at the first level of a top-
down geographical hierarchy. The full name should be expressed as a verbal name and not as a 
code, the ISO country code should be placed in the field titled ISO CountryCode. 
Note: This field is “shared” with the “Country” field in the Origin panel of the Adobe Photoshop 
File Info field. 
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ISO Country Code  [CountryCode] 
Enter the ISO Country Code of the country pictured in the photograph. This field is at the top/ first 
level of a top-down geographical hierarchy. Country codes should be displayed as upper-case letters 
(US not us), and may be either two- or three-letter codes as defined by the ISO 3166 standard. The 
two-letter code (3166-2) is freely available from  
the http://www.iso.org/iso/en/prods-services/iso3166ma/02iso-3166-code-lists/list-en1.html site.  
The full name of a country should go to the “Country” field. 
 
 
 

5 IPTC Status panel 
(use this panel to record workflow and copyright information) 

 

 
 

Title  [Title] 
This field can be used as a shorthand reference for the image or “photograph” — primarily for 
identification. The title of an image may take several forms; for photographers this might be the 
filename of their original scan or digital camera file, for news organizations it might be the name of 
the story for which it’s to be used. The Title term should not be confused with the Headline term, 
which is a short synopsis of the content of the photograph. 
Note: This field is “shared” with the “Document Title” field in the Description panel of the Adobe 
Photoshop File Info field. 
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Job Identifier  [JobID] 
You can enter a number or identifier that was created or issued for the purpose of improving 
workflow handling and image tracking. This ID should be added by the creator or provider for 
transmission and routing purposes only and should have no significance for archiving.  (please note 
that this same field was labelled as the “transmission reference” in previous versions of Adobe 
Photoshop). 
Note: This field is “shared” with the “Transmission Reference” field in the Origin panel of the 
Adobe Photoshop File Info field.  
 
Instructions  [Instructions]  
The Instructions field is a simple text field that can be used to include any of a number of 
instructions from the provider or creator to the receiver of the photograph.  Any of the following 
could be included: embargoes (News Magazines OUT) and other restrictions not covered by the 
“Rights Usage Terms” field; information regarding the original means of capture (scanning notes, 
colourspace info) or other specific text information that the user may need for accurate 
reproduction; additional permissions or credits required when publishing. 
Note: This field is “shared” with the “Instructions” field in the Origin panel of the Adobe 
Photoshop File Info field. 
 
 
Provider  [Provider] 
Use the Provider field to identify who is providing the photograph. This doesn’t have to necessarily 
be the owner/ creator. If a photographer is working for a news agency such as Reuters or the 
Associated Press, these organizations could be listed here as they are “providing” the image for use 
by others. If the image is a stock photograph, then the group (agency) involved in supplying the 
image should be listed here. 
Note: This field is “shared” with the “Credit” field in the Origin panel of the Adobe Photoshop 
File Info field. 
 
Source  [Source] 
The Source field should be used to identify the original owner or copyright holder of the 
photograph. The value of this field should never be changed after the information is entered 
following the image's creation. While not yet enforced by the custom panels, you should consider 
this to be a “write-once” field.  The source could be an individual, an agency, or a member of an 
agency. To aid in later searches, it is suggested to separate any slashes “/” with a blank space. Use 
the form “photographer / agency” rather than “photographer/agency.” Source may also be different 
from Creator and from the names listed in the Copyright Notice. 
Note: This field is “shared” with the “Source” field in the Origin panel of the Adobe Photoshop 
File Info field. 
 
Copyright Notice [CopyrightNotice] 
The Copyright Notice should contain any necessary copyright notice for claiming the intellectual 
property, and should identify the current owner(s) of the copyright for the photograph. Usually, this 
would be the photographer, but if the image was done by an employee or as work-for-hire, then the 
agency or company should be listed. Use the form appropriate to your country.  
 
For the United States you would typically follow the form of ©<date of first publication> name of 
copyright owner, as in “©2005 John Doe.”  Note, the word "copyright" or the abbreviation "copr" 
may be used in place of the © symbol. In some foreign countries only the copyright symbol is 
recognized and the abbreviation does not work. Furthermore the copyright symbol must be a full 
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circle with a "c" inside; using something like (c) where the parentheses form a partial circle is not 
sufficient. For additional protection worldwide, use of the phrase, “all rights reserved” following the 
notice above is encouraged.  
 
In Europe you would use: Copyright {Year} {Copyright owner}, all rights reserved. 
 
In Japan, for maximum protection, the following three items should appear in the copyright field of 
the IPTC Core: (a) the word, Copyright; (b) year of the first publication; and (c) name of the author. 
You may also wish to include the phrase “all rights reserved.” 
 
Notes regarding usage rights should be provided in the “Rights Usage Terms" field. 
 
Note: This field is “shared” with the “Copyright Notice” field in the Description panel of the 
Adobe Photoshop File Info field.   
 
Rights Usage Terms   [RightsUsageTerms] 
The Rights Usage Terms field should include text instructions on how this photograph can be 
legally used. For example, if you are only submitting the image(s) for consideration only, you can 
indicate that, and stipulate that no reproduction is allowed without permission being negotiated in 
advance. There are several groups working on terminology that can be used for rights management. 
It is strongly encouraged that you use a standardized set of terms or controlled vocabulary when 
populating this field.  
 
 
 

6 IPTC Core field samples for various types of photography  
 
On the following pages are three examples showing how you might fill out the IPTC Core metadata 
fields depending on the type of photography you do, and whom you are working for or with.  
 

continued  
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Example: Independent photographer 

 
Example photo provided by ©David Riecks 

-IPTC Contact  
Creator:   John Doe 
Creator's Jobtitle:  Photographer 
Address: John Doe Photography, 123 Maple Lane 
City: Champaign 
State/Province: Illinois 
Postal Code: 61820 
Country: USA 
Phone(s): +1 (217) 1234567 
Email(s): john@doe.com
Website(s): www.doe.com
-IPTC Content  
Headline: Young boy yelling 
Caption/Description: Three year old African American boy yells with joy on beach during vacation. 
Keywords: boy, gender, human beings, humans, lad, male, people, 3-12 years old, age, child, 

youth, african american, african-american, black, ethnic, ethnicity, people of 
color, race, beach, nature, scenery, emotion, emotional, emotions, happiness, 
happy, joy, joyful, joyous 

Subject Code: 14024001  *1(see note on page 17) 
Caption/Description writer: John Doe 
-IPTC Image  
Date Created: August 19, 2004 
Intellectual genre: Profile 
IPTC Scene: 012300   *2(see page 17) 
Location: Lake Superior 
City: Marquette 
State/Province: Michigan 
Country: USA 
ISO Country Code: US 
-IPTC Status  
Title: 20040819_pe_014578d.nef 
Job ID: PO 34567 
Instructions: Original RAW capture Nikon D2X, Adobe RGB 1998. 
Provider: John Doe Photography 
Source: John Doe Photography 
Copyright Notice: ©2004 John Doe, all rights reserved 
Rights Usage Terms: For consideration only, no reproduction without prior permission 
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Example:  Agency photographer 

 
Example photo provided by ©David Riecks 

-IPTC Contact  
Creator:   Julie Doe 
Creator's Jobtitle:  Mugwum contract photographer 
Address: Mugwum Press, 123 Broadway 
City: New York 
State/Province: New York 
Postal Code: 00123 
Country: USA 
Phone(s): +1 (877) 9876543 
Email(s): j.doe@mugwum.com
Website(s): www.mugwum.com
-IPTC Content  
Headline: Shore Temple, Malibalipuram, India 
Caption/Description: The Shore Temple of the Seven Pagodas was built under Narsimha II of the 

Pallava dynasty between 7th and 8th century AD and is dedicated to Lord Shiva. It 
resembles the structure of the Dharmaraja rath, but its tower rises much higher 
(approx. five stories or ~ 60 ft. high) and its stupa spire is small and slender.  

Keywords: land, monument, nature, scenery, architectural, architecture, building, place of 
worship, religious building, structures, temple, sacred place, sanctum, Asia, 
India, Malibalipuram, Tamil Nadu, night, moonlight, moon, skies, sky, blue 

Subject Code: 12000000, 01002000  *5 (see page 17) 
Caption/Description writer: Jacques Brown 
-IPTC Image  
Date Created: January 1, 2005 
Intellectual genre: Feature 
IPTC Scene: 011400     *6 (see page 17) 
Location: Shore Temple 
City: Malibalipuram 
State/Province: Tamil Nadu 
Country: India 
ISO Country Code: IN 
-IPTC Status  
Title: ar21319 
Job ID: Sacred India 
Instructions: Newsmagazines Out 
Provider: Mugwum Press 
Source: Julie Doe / Mugwum Press 
Copyright Notice: ©2005 Julie Doe / Mugwum Press, all rights reserved 
Rights Usage Terms: Image to be used One-time only, non-exclusive use in English Language Edition 

Magazine as inside image, to be used no larger than a full page in color. 
Additional third party rights to be negotiated with Julie Doe / Mugwum Press in 
advance. All other rights are reserved except those specifically granted. 
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Example: Staff photographer 

 
Example photo provided by ©David Riecks 

-IPTC Contact  
Creator:   John Doe 
Creator's Jobtitle:  Staff photographer 
Address: Big Newspaper, 123 Main Street 
City: Boston 
State/Province: Massachusetts 
Postal Code: 02134 
Country: USA 
Phone(s): +1 (800) 1234567 
Email(s): johndoe@bignewspaper.com
Website(s): www.bignewspaper.com
-IPTC Content  
Headline: Farmer planting onions 
Caption/Description: After digging the furrows another ten yards with the tractor, Jim Moore hops off 

to hand-set more leeks and onions. 
Keywords: agriculture, farm laborer, farmer, field hand, field worker, humans, occupation, 

people, agricultural, agronomy, crops, onions, vegetable crops, plants, 
vegetables, outdoors, outside, agricultural equipment, tractor, gender, male, men 

Subject Code: 04001000, 04001001 *3(see page 17) 
Caption/Description writer: Susan Brown 
-IPTC Image  
Date Created: April 3, 2003 
Intellectual genre: Profile 
IPTC Scene: 011900   *4 (see page 17) 
Location: Moore family farm 
City: Watseka 
State/Province: Illinois 
Country: USA 
ISO Country Code: US 
-IPTC Status  
Title: 01661gdx 
Job ID: CSA farms 
Instructions: Newspapers Out, Original Artixscan 4000 of color negative file, 160 ISO (frame 

35a) is 7.6 x 11.2 at 500ppi, in Colormatch RGB. 
Provider: Big Newspaper 
Source: John Doe / Big Newspaper 
Copyright Notice: ©2003 Big Newspaper, all rights reserved 
Rights Usage Terms: For consideration only, no reproduction without prior permission 
Notes from above examples 
*1- (this is the IPTC Subject code for “children”) 
*2- (this is the IPTC Scene code for “off-beat”) 
*3- (these are the IPTC Subject codes for “agriculture” and “arable farming”) 
*4- (this is the IPTC Scene code for “action”) 
*5- (these are the IPTC Subject codes for “religion & beliefs” and “architecture”) 
*6- (this is the IPTC Scene code for “night scene”) 
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7 Appendix 
7.1 Appendix section 1: Installing the panels 
 
Installing and Using the Panels with Adobe Photoshop CS and other Adobe Creative Suite 
Applications 
 
If, for some reason, your current version of Adobe Photoshop doesn’t contain the IPTC Core panels, 
you can download them from http://www.iptc.org/iptc4xmp/  
 
The information for the various custom panels are contained in the four text files labeled; 
IPTC_Contact, IPTC_Content, IPTC_Image, and IPTC_Status. The panels are installed either in a 
global, or user-specific directory.  
  
The following paths are correct for current operating systems and the Adobe Creative Suite of 
applications such as Adobe Photoshop CS. The items not in bold might be dependent upon the 
language of the installed operating system. 
 
On a Macintosh OSX system the custom panel files may be installed in either of the following 
locations: 
{Root Volume} /Library/Application Support/Adobe/XMP/Custom File Info Panels 
{Home Directory}/Users/<user name>/Library/Application Support/Adobe/XMP/Custom File Info 
Panels 
 
On Windows XP the files are installed in either of the following locations (substitute the 
appropriate drive letter for the “C” drive if necessary): 
C:\Documents and Settings\<user name>\Application Data\Adobe\ 
XMP\Custom File Info Panels 
C:\Program Files\Common Files\Adobe\XMP\Custom File Info Panels 
 
To use a custom panel, Select “File Info” from the “File” menu with a file open. Or, within the 
Adobe Photoshop File Browser, right-click (control+click on Macintosh) on a thumbnail image and 
select “File Info” from the contextual menu. When the File Info dialog opens, you can click on an 
IPTC Core panel name in the list of panel in the list at the left side of the dialog box. 
 
NOTE: 
The IPTC also provides a Windows-only installer program to move the panels to the correct 
location in your file system. 
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7.2 Appendix section 2: creating metadata templates 
How to create metadata templates and batch apply them in Adobe Photoshop CS  
 
Creation  
1. Start with a fresh new document in any CS app.  
2. Go to File Info and enter the data for which you wish to create a template.  
3. Save template - go to the upper right flyout (circle with arrow in it) and select save - name it 
whatever you want.  
4. Cancel File Info  
5. Discard new document  
 
Apply to Single Image  
1. Open a file and select File Info  
2. Select from the flyout menu the template you wish to append (control click to replace)  
 
Batch Apply  
1. Select multiple files in the Adobe Photoshop file browser  
2. Select Edit > Append Metadata or Edit > Replace Metadata  
 
Append vs. Replace  
Append will add values to properties that are empty and add properties & values if they are not 
present. 
 
Replace will add properties & values if they are not present and will replace values for those 
properties that exist.  
 
Append and Replace are also available from the Advanced panel of the File Info dialog. 
 
Delete  
Properties can be deleted via the Advanced Panel of the File Info dialog. (Presumably there also 
ways of editing template files to apply 'blank' or null values but you will need to experiment to get 
the results you need). 

 
 

7.3 Appendix section 3, Mapping IPTC IIMv4 to IPTC Core 
 

continued (3 pages)  
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Appendix Section 3
IPTC - IIMv4 & "IPTC Core" v1.0 Schema for XMP Fields mapped to Imaging Program Labels
IIM Image Info
Field IPTC IIMv4 field name size § IPTC Core (XMP) Label Photoshop CS Toolkit 1.5 **

*05 Object Name (Title) 64 Title Document title Object Name
10 Urgency 1 deprecated Urgency Urgency
15 Category 3 deprecated Categories Category
20 Supplemental Categories 32 deprecated Suppl. Categories Suppl. Categories
25 Keywords 64 Keywords Keywords Keywords
40 Special Instructions 256 Instructions Instructions Special Instructions
55 Date Created 8 Date Created Date Created Date Created
80 By-line (Author) 32 Creator Author By-line Author
85 By-line Title(Author position) 32 Creator's Jobtitle (not seen in file info) By-line Title
90 City 32 City City City
95 Province/State 32 State/Province State/Province State

101 Country/Primary Location Name 64 Country Country Country
103 Original Transmission Reference 32 Job Identifier Transmission Reference Transmission
105 Headline 256 Headline Headline Headline
110 Credit 32 Provider Credit Credit
115 Source 32 Source Source Source
116 Copyright Notice 128 Copyright Notice Copyright Notice Copyright
120 Caption/Abstract 2000 Caption/Description Description Caption/Abstract
122 Writer/Editor 32 Caption/Description Writer Description Writer Writer/Editor

Creator's Contact Info:City
Creator's Contact Info:Country
Creator's Contact Info:Address
Creator's Contact Info: Postal Code
Creator's Contact Info:State/Province
Creator's Contact Info:Email(s)
Creator's Contact Info:Phone(s)
Creator's Contact Info:WebURL(s)
ISO Country Code
Intellectual genre
Location
Rights Usage Terms
Subject Code
IPTC Scene

7 Edit Status 32
22 Fixture Identifier 32
27 Content Location Name 64

118 Contact 128
Copyright Info URL
Copyright Status

magenta = fields slated for removal ("deprecated") from the IPTC Core Schema
dark green = new fields introduced in the IPTC Core schema
Fields in red will not be read in any programs except Photoshop, and/or other programs using the Adobe "File Info" data format

Fields in blue are part of the IPTC IIMv4 schema, and used by iView, but not visible by any other programs except via plug-ins

*  Field number as denoted in the Information Interchange Module version 4 by IPTC

§ count for IIMv4 data includes characters, carriage-returns, linefeeds and spaces, do not exceed for maximum backwards compatibility

** handles IPTC in TIF and Jpeg files

† handles IPTC in Jpeg files only

latest version at: http://www.controlledvocabulary.com/imagedatabases/iptc_core_mapped.pdf
27.01.2005 ©2005 David Riecks, used by permission



IIM
Field IPTC IIMv4 field name size § Photoshop 7.01 Photoshop 6 Irfanview †

*05 Object Name (Title) 64 Title Object Name Object Name
10 Urgency 1 Urgency Urgency Urgency
15 Category 3 Categories Categories Categories
20 Supplemental Categories 32 Suppl. Categories Suppl. Categories Suppl. Categories
25 Keywords 64 Keywords Keywords Keywords
40 Special Instructions 256 Instructions Special Instructions Special Instructions
55 Date Created 8 Date Created Date Created Date Created
80 By-line (Author) 32 Author Byline Byline
85 By-line Title(Author position) 32 Authors Position Byline Title Byline Title
90 City 32 City City City
95 Province/State 32 State/Province Province-State Province-State

101 Country/Primary Location Name 64 Country Country name Country
103 Original Transmission Reference 32 Transmission Reference Original Transmission Ref. Original Transmission Ref.
105 Headline 256 Headline Headline Headline
110 Credit 32 Credit Credit Credit
115 Source 32 Source Source Source
116 Copyright Notice 128 Copyright Notice Copyright Notice Copyright
120 Caption/Abstract 2000 Caption Caption Caption
122 Writer/Editor 32 Caption Writer Caption Writer Caption Writer

7 Edit Status 32
22 Fixture Identifier 32 Job Name
27 Content Location Name 64

118 Contact 128
Owner URL Image URL
Copyright Status Mark as Copyrighted

Fields in red will not be read in any programs except Photoshop, and/or other programs using the Adobe "File Info" data format

Fields in blue are part of the IPTC IIMv4 schema, and used by iView, but not visible by any other programs except via plug-ins

*  Field number as denoted in the Information Interchange Module version 4 by IPTC

§ count for IIMv4 data includes characters, carriage-returns, linefeeds and spaces, do not exceed for maximum backwards compatibility

** handles IPTC in TIF and Jpeg files

† handles IPTC in Jpeg files only



IIM Photoshop
Field IPTC IIMv4 field name size § iView Media Pro 2.6 Thumbsplus Elements 3

*05 Object Name (Title) 64 Product Object Name Document title
10 Urgency 1 Color Label Urgency
15 Category 3 Genre Suppl. Categories Categories
20 Supplemental Categories 32 Categories Categories Suppl. Categories
25 Keywords 64 Keywords Keywords Keywords
40 Special Instructions 256 Instructions Special Instructions
55 Date Created 8 Event Date Date Created
80 By-line (Author) 32 Author Byline Author
85 By-line Title(Author position) 32 author title Title
90 City 32 City City
95 Province/State 32 State Province-State

101 Country/Primary Location Name 64 Country Country
103 Original Transmission Reference 32 Transmission Xmit ref
105 Headline 256 Title Headline
110 Credit 32 Credit Credit
115 Source 32 Source Source
116 Copyright Notice 128 Copyright Copyright Notice Copyright Notice
120 Caption/Abstract 2000 Caption Caption Description
122 Writer/Editor 32 Writer Writer/editor Description Writer

7 Edit Status 32 Status
22 Fixture Identifier 32 Event
27 Content Location Name 64 Location

118 Contact 128 People
Copyright Info URL
Copyright Status

Fields in red will not be read in any programs except Photoshop, and/or other programs using the Adobe "File Info" data format

Fields in blue are part of the IPTC IIMv4 schema, and used by iView, but not visible by any other programs except via plug-ins

*  Field number as denoted in the Information Interchange Module version 4 by IPTC

§ count for IIMv4 data includes characters, carriage-returns, linefeeds and spaces, do not exceed for maximum backwards compatibility

** handles IPTC in TIF and Jpeg files

† handles IPTC in Jpeg files only
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